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Pol-Analyzer, OpenPolScope software (ver. 3.0) for ImageJ 

Last Updated: March 22, 2017; Revision 1.08 

This manual was prepared with Pol-Analyzer software version 3.0 and 
Birefringence Processing enabled. Separate manuals are available for Dichroism and 
Fluorescence Polarization. Please refer under the Help section for those. 

Copyright, license, and warranty/disclaimer statements at end of document. 
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Before Installation 
OpenPolScope plugins come in two flavors, which are installed in different plugin folders inside 

the Micro-Manager folder: 

1. Pol-Acquisition plugin; after its installation into the MMplugins folder, this plugin 
appears in the Micro-Manager Plugins menu. It is used to acquire PolScope images, 
applying PolScope algorithms and controlling the OpenPolScope hardware attached 
to the microscope. 

2. Pol-Analyzer plugin; after its installation into the plugins folder, this plugin appears 
in the ImageJ Plugins menu, providing functions to view and analyze PolScope data 
that have been previously acquired. 

The OpenPolScope software installer installs both plugins. The Demo version only 
installs the Pol-Analyzer plugin. 

Software requirements 
1. Micro-Manager (tested with release 1.4.22 subsequent changes in Micro-Manager 

code might result in unexpected behavior) 

2. OpenPolScope software : https://openpolscope.org/pages/Downloads.htm 
Installer for Windows XP up to Windows10 
Installer for Mac 

Note: Currently only VariLC and a Filter Wheel implementation is compatible with the Mac 
version for Acquisition. 

OpenPolScope software components 
Micro-Manager Plugins menu: 

Pol-Acquisition, FrameAverager, TopFrame 

Image J Plugins menu 
PolScope: Pol-Analyzer; Orientation-Lines 

PolScope Legacy: RatioAzimPolStackToRGB_V2; ROI_Averages_With_Lines_V1; 
StackAverage_ 

Java Console 

Minimum and recommended system requirements 
Hardware: 

1. OpenPolScope hardware, consisting of liquid-crystal (LC) universal compensator 
and VariLC or equivalent electronic controller. 

2. Camera, supported by Micro-Manager 

3. Computer recommended 1.5GHz CPU dual core, 64-bit 

4. 2 GB RAM  (recommended 4 GB RAM) dependant on camera. 

5. 10 MB Hard Disk Space (additional space required for UserData) 

 

 

 

https://openpolscope.org/pages/Downloads.htm
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Software: 

1. Windows XP, Windows 7, Mac (32/64 bit) 
(OpenPolScope software is currently not tested on Mac) 

2. Java 1.6 update 31 (included in Micro-Manager for Windows) 

 

Note: It is recommended to increase the ImageJ memory (Edit>Options>Memory…) to a 
minimum of 1024MB or more for smooth camera operations. 

 

Guide to abbreviations 
VariLC Digital controller for liquid crystal devices. The controller, which might have 

a name different from VariLC, is connected to the computer through a serial 
or USB cable. 

File naming SM_2012_0904_0213_5 Prefix: 
convention  SM – Sample 

Prefix_Year_MonthDate_HourMin_Suffix BG – Background 
 SMS - Sample Series 
 (Multi-Dimensional) 

 

OpenPolScope data directory structure 
Pol-Acquisition organizes the image data according to the following directory tree: 

<LCPolScopeData> --------- (user chosen top directory) 

| 

<UserName1> --------- (contains directories of a single user/project) 

| 

<SessionDate1> --- (contains image and metadata files of a day’s session) 

| 

<SessionDate2> 

<UserName2> --------- (contains directories of another user/project) 

| 

<SessionDate1> --- (contains image and metadata files of a day’s session) 

| 

<SessionDate2> 
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Installation 
 

 

For using the Pol-Analyzer plugin, a little familiarity with ImageJ is useful. The plugin is 
installed into the Micro-Manager plugins folder and appears under the Plugins menu, 
providing functions to view and analyze PolScope data that have been previously acquired. 
Image data need to be formatted as Micro-Manager stacks (not ImageJ stacks). Therefore, 
in its current release, Pol-Analyzer requires the co-installation of Micro-Manager. 
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When installed in Fiji or ImageJ The Pol-Analyzer plugin can be accessed from the ImageJ 
Plugins menu. 

 

 

The OpenPolScope plugin suite for ImageJ contains a few extra useful plugins. 

The Orientation-LinesV3 plugin can be used to set parameters in a single query panel and 
will operate on an open and active PolScope stack (Micro-Manager and ImageJ stack 
format). 

The Abrio File Opener/Metadata supports opening Abrio acquired image datasets that 
typically have a file extension (*.pli). 

The PolScope Legacy entry contains plugins that operate only on traditional ImageJ 
PolScope stacks (ImageJ stacks) 
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Pol-Analyzer Window 
The Pol-Analyzer window contains action buttons, a progress bar, and several tabs that let 
the user set data locations, measurement parameters, options, etc. The following sections 
give an overview of the window components. 

 

 

 

 

 

 



Pol-Analyzer User Manual, Birefringence Imaging 7 | P a g e  

 

Overview of Functionality and Tabs 
 

The top line shows the folder 
names of the current 
User/Project and Session. 

The Process button initiates 
the recalculation of the image 
data as specified by the 
settings in the tab panels 

The progress bar gives an 
estimate of the completion of 
an active process. 

Status messages are printed 
below the bar. 

Data tab 
In the Data tab panel, the root 
folder Data Location can be 
selected, where Micro-
Manager data were saved. The 
lists of existing User and 

Session folders are then loaded into their corresponding pull down menus. 

Note: The PolScope-Analyzer only works on existing data. Use the Pol-Acquisition plugin to 
acquire new PolScope images 

Session Description: This description is imported when the Session was created and can be 
updated during Processing. 

Saving 

Overwrite Original Processed Images: Enable this option to overwrite previously computed 
images. Default is enabled. 

Show Overwrite Confirmation message: When enabled, prompts for a confirmation before 
previously computed data are overwritten. Default is enabled. 

Note: If overwrite is enabled, only processed images are overwritten. Raw images are 
never modified or overwritten. 

Note: Newly computed data can only be saved by overwriting previous results at the time 
of generating the new results. If Overwriting Original Processed Images is not checked, the 
newly computed data, displayed in the stack, can only be saved to disk as a new, complete 
data stack, because Save commands in Micro-Manager don’t allow overwriting previous 
data. 
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Parameters tab 

This tab lets the user select the 
image window that holds the 
sample data (Processed Data) 
to be processed and the 
associated background data, if 
available. Pull-down menus let 
the user choose between 
available datasets. Depending 
on the check box settings in 
the Options panel, the entries 
in the sample pull down menu 
vary. The Open button lets the 
user open sample data from 
the disk. 

The tab also shows 
measurement parameters at 
the time of acquisition or last 

processing. The information displayed here is stored in the metadata file and parsed when 
the dataset is loaded. 

These parameters should not require any modifications. However, if background correction 
was not applied during acquisition or other parameters were not correct, the values can be 
edited and once reprocessed are saved to the image metadata. 

Image-Path Mirror: Used for an Inverted microscope or if there is a mirror in the optical 
path. Setting the mirror parameter inappropriately leads to incorrectly computed 
orientation values. Retardance values are not affected by the mirror setting. 

Wavelength: Sets the wavelength that will be used when setting the retardance values. 
Default is 546 nm. 

Swing: Sets the nominal retardance bias (as a fraction of the wavelength) for the elliptical 
settings of the liquid crystals. 

Black Level: The blacklevel is the average pixel value that is measured when the camera is 
not illuminated. The black level primarily depends on the camera offset setting. 
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Birefringence tab 

 The main processor 
selected in the Processing 
panel (here Birefringence) 
will be displayed as an 
additional tab. Its panel 
will contain options only 
applicable when this 
processor is selected. 

Retardance Ceiling: Sets 
the value of the retardance 
ceiling that is used for 
storing the retardance 
values in its image channel 
(usually first image). By 
way of explanation, all 
image data are stored as 8 
bit or 16 bit pixel values, 
including the computed or 
virtual channels. For 
display and storage, 
computed retardance 
values are converted to 8- 
or 16-bit integer values, 

linearly mapping the retardance between 0 and the ceiling value into 0 and 255 (8-bit) or 0 
and 4095 (16-bit). 4095 was chosen to make the converted retardance values similar to the 
intensity values acquired by a 12-bit camera. Retardance values that are computed to be 
higher than the ceiling value are stored as 255 or 4095. 

Auto Calculate Retardance Ceiling: When enabled the software will calculate the retardance 
based on the highest retardance value it finds within the calculated retardance image. This 
might not be a true representation of the data in cases where there is debris within the 
sample space. 

Orientation Reference: Sets the orientation reference that is used for processing the slow 
axis orientation image. (See Pol-Acquisition manual, sections “Calibration of calculated 
retardance and orientation values” and “Mapping of calculated retardance and orientation 
values into 8-bit and 16-bit images”) 

Algorithms 
Acquire Using: Option to acquire only 4 frames instead of the default 5 frames, dropping 
the acquisition of the raw image for Setting 4. 

Process Using: Option to use only 4 frames for processing instead of 5 frames.  

Note: 5-frame processing requires an activation key. This is available for free for all VariLC 
users and those Meadowlark LC users who have purchased the unit via the OpenPolScope 
Resource at MBL. Please send us a note to request an activation key. 
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Convert Non Micro-Manager PolStack to Mmgr Dataset : This option allows converting 
PolStack acquired using Psj or any software to be converted as a Micro-Manager PolStack. 
Default values might be used to populate metadata field and once converted the new 
dataset should be re-processed with correct parameters (eg. Background, retardance 
ceiling, swing, etc.) 

 

Create Test Dataset: This button allows either loading of a test dataset or creating a test 
dataset based on User defined parameters. Additional test datasests can be downloaded 
from the OpenPolScope website https://openpolscope.org/pages/Sample_Datasets.htm 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://openpolscope.org/pages/Sample_Datasets.htm
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Processing tab 

The Processing tab is divided 
into 3 main segments. 

PreProcessing: This applies 
some modifications to the raw 
image data before they are 
sent to the main processor. An 
example is Ratioing in which 
the pixel values of the sample 
images are multiplied by a 
correction factor calculated 
based on the background 
images. Multiple Preprocessors 
can be selected. 

Note: The raw image data that 
are stored in the raw image 
channels are never altered 
during any processing steps, 
including preprocessing and 
postprocessing. 

Processing Mode: This is the 
main processor, which controls the processing algorithms. It defines the number of raw 
images expected; the number of computed images, which are also called virtual channels; 
the computation algorithm for the virtual channel images; along with other parameters. 
Only one Processing Mode can be selected. A Processing Mode has its own options tab (eg. 
Birefringence). 

PostProcessing: This applies some post-processing correction to the images. It can also be 
used to generate additional images. Multiple Postprocessors can be selected. 

Note: All the OpenPolScope processors that are currently installed will be displayed in this 
tab. 

Note: Pre/PostProcessor may or may not have additional options that are indicated by a 
button. 

Note: If a PolScope data set is opened and the associated Processing Mode plugin is not 
installed, the data-set will open as a regular Micro-Manager data-set and not a PolScope 
data-set. 
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Options tab 

In the Options tab one can 
set preferences for the Pol-
Analyzer. 

Processing: 

Process stacks: If checked, 
processing occurs for all 
computed channels of a 
data-set (stack); if not 
checked, processing occurs 
only for the currently 
selected time-point and/or 
z-position. Default is 
enabled. 

 

Run Processing from Slider: When enabled will execute processing whenever a value is 
changed from the slider (eg. Retardance ceiling slider). Default is disabled. 

Dont Process...: This option allows walking the data-set through time, slice, position 
without processing. The currently selected channel is always displayed. 

Parallelize Processing: Enables processing using multiple cpu cores that are available. This 
option provides full utilization of processing power when processing a Multi-dimentional 
stack. This should not be enabled when acquiring images and Processing at the same time. 
Default is enabled. 

Program: 

Show only Open Windows...: Modifies the behavior of the 'Open...' button under Parameters 
to List view instead of File dialog opener. Default is enabled. 

Batch Processing Mode: Selecting this option provides a BatchMode panel for batch 
processing multi datasets. The Process button is transformed for 'Batch Process' and its 
corresponding panel is added next to Options panel. 
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BatchMode tab 

 
 

Batch Processing allows certain parameters that are Batch Processable to be applied to all datasets 

within a session. Once selected by enabling their checkbox, those values and/or selections will be 

applied to all the datasets that have been selected for Processing. 

 

 
Note: During Batch Processing mode 'Open windows' will be ignored and the datasets 
required for processing can be selected from the panel's table-view. The currently selected 
Processing Mode is the default method used. If a Session consists of different type 
(different modes) of acquired data, those other datasets will be skipped when processing. 
Datasets that cannot be processed will continue to have their checkbox tick marks while 
the ones that have been processed will have their tick marks removed. 
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Logger tab 

 

This tab creates a chronological event log for the Session. The log file (session_log.txt) 
resides in the User's session directory. Other than providing basic User information, all 
images acquired in Micro-Manager are logged in this log file. A User can also add their own 
comments and notes in the text area regarding their experiments. 
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PolScope image stack: The information at the bottom of a PolScope stack includes pixel values 
in terms of the properties defined by the processor. The Birefringence processor will display the 
Retardance value of a pixel. 

 

Orientation Cursor: This 
checkbox transforms the 
image cursor to a line cursor 
that displays the orientation 
of a pixel when hovered 
over the image. 

Orient. Lines: This check box 
causes an overlay of 
orientation lines to be 
drawn inside a specified ROI. 
Parameters such as the line 
interval are set with the 
Orientation-LinesV3 plugin 
button on the Viewer. In a 
series, the lines are re-
calculated for each time-
point and/or z-slice. 

 

 

 

 

 

 

The Pol-Acquisition routine writes metadata and comments in the Micro-Manager Metadata 
panel. 
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Help 

The Help menu can be accessed from the file menu located at the top. 

 

Manuals 
More helpful manuals, protocols and support files are available under this section including a 
link for online Documentation section of the OpenPolScope website 
(https://openpolscope.org/pages/Documentation.htm) 

Report Tool 

 

The Report tool can be accessed via Help in the Menu bar to send bug reports or 
suggestions. 

 

https://openpolscope.org/pages/Documentation.htm
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ChangeLog 

 

The ChangeLog allows viewing the latest changes and fixes that are incorporated in each new 
version released. 

Preferences 

 

The Preferences panel allows access to experimental options that are currently in test phase of 
development. They should only be enabled once advised by an OpenPolScope team member. 

 

 



Pol-Analyzer User Manual, Birefringence Imaging 18 | P a g e  

 
About 
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Appendix: A 

Calibrating the OpenPolScope for measurement of slow axis of birefringence using 
cheek cells 
 

Step 1: After swabing cheek cells onto coverslip and immersing it in saliva (isotonic immersion), 

setup Kohler illumination. Cheek cells do not refract light much, so we need to have some type of 

contrast enhancement. Reducing the illumination aperture by stopping down the condenser NA 

(one of the simplest type of cohtrast enhancement ) works well. When Kohler illumination is setup 

and condenser NA is stopped down, we see something like this: 
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Figure 1: Kohler aligned microscope. The hexagonal aperture visible in the specimen plane is the 

field stop. The aperture stop of the condenser was closed down to be smallest. 

 

Step:2 Now open both the field stop and aperture stop slightly, choose a ROI over background re-

gion and calibrate the VariLC. Notice that as aperture stop is opened, image has better resolution, 

but poorer contrast. The results are explained in screenshots that follow: 

 
Figure 2a: Calibration was done by choosing a ROI over background as shown. The above image 

was acquired with VariLC set to setting-1 after calibration. 
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Figure 2b: At the end of calibration, the VariLC panel is populated with appropriate retardance 

values for LC-A and LC-B as shown above. High extinction ratio indicates that calibration was suc-

cessful. 
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Step 3: Acquire background. We notice in above image that there is uneven illumination of the 

specimen. This and similar other imperfections in the optics are accounted for by a background 

Polstack. Move to an area of coverslip, where no specimen is present and acquire a background 

stack by pressing “BG” button on Pol-Acquisition plugin. 

 

Figure 3: Background captures effect of uneven illumination. The field-stop may be considered an 

uneven illumination at specimen plane. 
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Step 4: Acquire sample stack and ensure that the slow axis orientation is along the edge of the cell. 
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Copyright, license, warranty/disclaimer 
 

Copyright © 2009 - 2017, Marine Biological Laboratory 

NOTICE: Some of the algorithms herein are protected by US patent #5521705, #7202950 
and other patents applied for or pending. 

LICENSE (Berkeley Software Distribution License): Redistribution and use in source and 
binary forms, with or without modification, are permitted provided that the following 
conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

3. Neither the name of the Marine Biological Laboratory nor the names of its 
contributors may be used to endorse or promote products derived from this 
software without specific prior written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

The views and conclusions contained in the software and documentation are those of the 
authors and should not be interpreted as representing official policies, either expressed or 
implied, of any organization. 

 

From the Laboratory of 
Rudolf Oldenbourg (rudolfo@mbl.edu) 

Cellular Dynamics Program 
Marine Biological Lab, 

Woods Hole, MA 
USA 
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